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Let’s Connect!



Today’s 
Demonstration

Part 1:  Simple Overview of Excel 3D Maps
oObtaining CCHS data 

o Structuring Our Data

o Creating a 3D Map

o Configuring Our Map

oMaking It Pretty

Part 2:  Creating a Type 2 Diabetes Risk Map for Ottawa
oObtaining 2016 Census demographic data 

o Computing a composite ‘Risk Score’ 

oMapping the data using Custom Region shapefiles
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Using Excel’s 
3D Maps

Pre-Requisites

1. You have Excel 2016 or later.
Excel 2013 requires installing the Power Map add-in and will not have 
all of the newest features (Importing custom regions) 

2. You have a location variable for each record (row) in your 
data table (e.g. CT, DA, Postal Code, City). 

3. If your geography of interest is anything other than ‘standard 
geographies’ – postal codes, cities or provinces – you have 
boundary shapefiles (.shp) to define your custom regions. 

***Important: Your shapefile must be formatted as a ‘WGS 1984 
coordinate system’ shapefile to play nice with Excel. 

4

http://www.microsoft.com/en-us/download/details.aspx?id=38395


Part 1  - Simple 
Overview of 
Excel 3D Maps
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Let’s Generate 
Some Data!

Steps
1. Go to the CCHS CANSIM webpage: 

https://www150.statcan.gc.ca/t1/tbl1/en/tv.action?pid=131
0009601

2. Create a simple table (1 indicator) of interesting health 
data, with indicators as columns and geography, age, 
gender and reference period as rows.

3. Ensure the table has no missing data; download the csv ‘as 
displayed’ 6

https://www150.statcan.gc.ca/t1/tbl1/en/tv.action?pid=1310009601


Structuring 
Our Data

Steps
4. Clean the data: ‘Fill down’ (ctl+d) any missing categorical data for each 

record (e.g. geography and age in this case)
5. Format as Table: Select table data. On the Home tab, click Format as Table. 

Make sure there are no empty cells in the table. Save as an .xlsx file.
6. Format ‘Time’ data: Create column ‘Time’ with a date format beside 

Reference Period (=DATE([@[Reference period]],1,1)). Copy ‘Time’ values 
and ‘Paste Values’ in place. Delete ‘Reference Period’ column. 7



Creating a 
Simple 3D Map

Steps
7. Select the table and launch 3D Maps: On the Insert tab, click 3D Map
8. Define your point locations. (In this case, Excel has correctly deduced that the 

‘Geography’ field refers to provinces and has mapped our data appropriately) 
9. Choose the appropriate Visualization Type. In this case, we’ll select ‘Region’.
10. Add Map Labels and try toggling the Flat Map feature from the ribbon
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Configuring 
Our 3D Map

Steps
11. Define your Y value. Let’s choose ‘Has a regular HC provider’ under ‘Value’. 

Click the dropdown and choose ‘Average’. 
12. Let’s pick ‘Age Group’ as our Category variable. Choose to ‘Shade based on 

category value compared to other values in the category’ (see picture).
13. Let’s pick ‘Time’ as our Time variable. Click the time dropdown and select 

‘Year’ only. Notice that a playback button appears!
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Perfecting Our 
3D Map

Steps
14. Let’s create 2 layers – one for each age category. Under Filter, choose to ‘Add 

Filter’ and select the Age Group field.
15. Rename your current layer as ‘Has Regular Provider (50-64y)’ 
16. Add Layer named ‘Has Regular Provider (65+y)’  with identical settings, but 

filtered to show only data for Age Group ‘65 or older’. 
17. Double-click time marker in top left corner and display only Year
18. Toggle layers on and off by clicking on the eye-shaped icon. Hide 1 layer.
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Perfecting Our 
3D Map

Steps
19. Let’s click ‘Play’ and see what happens!

What do the colour patterns tell us about our data? Which province’s rate 
changes most noticeably over time?
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Annotating 
Our 3D Map

Steps
19. Right-click on province(s) of interest and ‘Add Annotation’
20. Under TITLE, select Custom and type in the province’s abbreviation
21. Under DESCRIPTION, select the field of interest (Has Regular Provider)
22. Let’s click ‘Play’ and see what happens!

Which province’s rate changes most noticeably over time? 12



Why is this 
valuable?

 Until now, knowledge users only had access to whatever 2D maps were 
created for them by knowledge brokers.  (May or may not be what they need.)

 Until now, creating useful maps has required GIS software and expertise. If 
your non-profit doesn’t have a GIS person, odds are you are not seeing your 
geospatial data at all! (despite having lots of it)

Now, it is possible to quickly mine any organizational and publicly available data 
spatially for insights. Analysts can set up useful DATA TOOLS for staff/mgmt.

Examples of planning applications

Multicultural Outreach Where do our single-parent newcomer families 
live?

Route Planning for Mobile Harm 
Reduction Services 

Where are opiate-related overdoses occurring 
within my catchment?

Community Development What neighbourhoods have the poorest sense of 
community belonging?

Targeted Diabetes Screening 
Events

What neighbourhoods are at highest risk of 
undiagnosed type 2 Diabetes?
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What About 
Using Non-
Standard 
Geographies?

By Default, Excel 3D Maps will recognize the location of the following variables:
 Country
 Province/State
 City
 Street Address
 Forward Sortation Area
 Postal/Zip Code
 Latitude/Longitude

However, the most useful way to visualize your data is likely to be by:
 Neighbourhood
 Catchment
 Census Geography (CT, CMA, DA, etc.)
 Other

CAN THIS BE DONE??
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What About 
Using Non-
Standard 
Geographies?
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Part 2  -
Creating a Type 2 
Diabetes Risk 
Map for Ottawa
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Champlain 
SCREEN 
Program: 
Background

 As a regional Diabetes screening program, the goal is to: 

 identify high-risk communities (e.g. seniors, certain ethnicities, etc.)

 leverage existing groups in those communities to host screening events

 pre-screen participants using a questionnaire

 For higher risk individuals, test A1c levels (blood test)

 So that higher risk individuals can:

 Know their risk of having or developing diabetes

 Be referred to the Diabetes Education Program

 Receive information about how to find a family doctor if they don’t have one

 Be sent to their doctor with a letter, for formal medical diagnosis, if they have one

 In urgent cases, be referred directly to a specialist (endocrinologist)
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Champlain 
SCREEN 
Program: 
Background

 As a business problem, diabetes screening is similar, in 

some ways, to mining:

 To be successful, we have to find concentrated 

deposits of high-quality ore (i.e. high risk 

individuals) within a broad geographic area

 We can use information about the landscape (i.e. 

Census demographic profile) to guess where 

hotspots might be

 We have to validate these assumptions by taking 

samples (i.e. A1C tests at SCREEN events) 

 How diabetes screening is NOT like mining:

 The ‘ore’ is constantly moving around!
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Our Approach

 Looking at the CANRISK 
Assessment, we can see 
what variables are most 
predictive of Diabetes Risk:

 Age

 Body Mass Index

 Episodic Hyperglycemia

 Ethnicity

 Sex

 Waist Circumference

 Educational Attainment

 High Blood Pressure

 Family History of Diabetes
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Our Approach

 Looking at the CANRISK 
Assessment, we can see 
what variables are most 
predictive of Diabetes Risk:

 Age

 Body Mass Index

 Episodic Hyperglycemia

 Ethnicity

 Sex

 Waist Circumference

 Educational Attainment

 High Blood Pressure

 Family History of Diabetes
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Available in the 2016 
Census Profile

✓

✓

✓

✓



Our Approach
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What If…

we were to create a map of Ottawa and assign different 

areas a weighted ‘CANRISK’ score based on the 4 

demographic variables available from the 2016 Census?

Let’s try it!



Choosing a 
Geographic 
Scale
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Choosing a 
Geographic 
Scale
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Choosing a 
Geographic 
Scale
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Census Subdivisions (CSD)  Municipalities (as determined by 
provincial/territorial legislation) or areas treated as municipal equivalents 
for statistical purposes



Choosing a 
Geographic 
Scale
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Forward Sortation Areas (FSA)  First 3 characters of a postal code



Choosing a 
Geographic 
Scale
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Census Tracts (CT) Small, relatively stable geographic areas that 
usually have a population of less than 10,000 persons (2,500 to 10,000)



Choosing a 
Geographic 
Scale

27
Aggregate Dissemination Areas (ADA) Census Tracts 
grouped, where necessary, to meet population of 5,000 to 15,000 



Choosing a 
Geographic 
Scale
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Dissemination Areas (DA) Small, relatively stable geographic unit 
composed of one or more adjacent dissemination blocks with an average 
population of 400 to 700 persons



Choosing a 
Geographic 
Scale
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Obtaining 
Census Data

[Need to have Beyond 20/20 
browser installed for this step]

Steps
1. Go to CommunityData.ca and click the ‘Find Data’ button
2. Select ‘Census, 2016 – Profile’ and click the ‘Apply Filters’ button
3. Click on Census Profile, 2016’ and follow the link in the description
4. Download the .IVT table containing Dissemination Areas (DA)

Since the file is very large (932MB), feel free simply to follow along.  
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Obtaining 
Census Data

[Need to have Beyond 20/20 
browser installed for this step]

Steps
5. After opening the IVT table, let’s find the rows of data that will be of interest 

for our 4 diabetes predictors: Age, Sex, Ethnicity and Educational 
Attainment. Find the table rows corresponding to age.

6. Using the Search function         , search fields for English Description 
containing ‘ethnic’. Select ‘Find Next’ and ‘OK’ to search.

7. Repeat this step, searching for ‘education’.
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Obtaining 
Census Data

[Need to have Beyond 20/20 
browser installed for this step]

Steps
8. Delete (“Hide”) all fields other than those of interest: Age groups, 

Aboriginal Ancestry, Visible Minority, Highest Education (+25y), and Sex
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Obtaining 
Census Data

[Need to have Beyond 20/20 
browser installed for this step]

Steps
9. Now let’s make visible only the Ottawa dissemination area (DA) data. 

Click and drag the Geography tab on the top left, down to where the 
Census Profile fields are currently showing.

10. Search the Geography fields for ‘Ottawa’ (English desc). Delete all 
records that are not Ottawa DAs (only keep 3506001 – 35061901) 33



Obtaining 
Census Data

[Need to have Beyond 20/20 
browser installed for this step]

Steps
11. Drag ‘Profile’ to the right so that Profile fields appear as columns
12. Drag ‘Sex’ tab between the DA column and the 1st Profile column
13. ‘Save As’ an Excel Spreadsheet (.xls) and open
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Calculating a 
CANRISK Score
for Ottawa DAs

Steps
14. Create a new column to the right of the 1st one containing DA number: 

This will be for our CANRISK Score. Using the CANRISK Tool as a guide, 
assign weights to age, sex, ethnicity and education level as follows:

15. B4 =(6*(D5)+7*(SUM(P4:Q4))+13*(SUM(R4:S4))+15*(T4)+3*(AD4-
AY4)+5*(BD4)+10*(SUM(BC4,BE4,BJ4,BK4))+11*SUM(BH4,BB4)+3*(S
UM(BF4,BG4,BI4,BL4,BM4))+5*(BP4)+1*(BQ4))/D4 35



Calculating a 
CANRISK Score
for Ottawa DAs

Steps
16. Paste this formula all the way down by selecting B4:B4119 and pressing 

Ctrl+D
17. Select Columns A & B, Copy, and Paste “as values” into a new tab
18. ‘Format as table’  and filter ‘Geography’ so that only DAs are showing. This 

is just a lazy way of not having to manually erase 8,000+ rows of junk data
36



Formatting Our 
Data

Steps
19. Looking at the Geography data, you can see that it is a long string 

containing not only the DA identifier but also parentheses and 
percentages. Let’s remove those by creating a new field called DAUID. 

20. First cell value will = LEFT(A2,9). We are grabbing the 9 left-most digits 
of the long string and leaving out the rest. 
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Formatting Our 
Data

Steps
21. Time for some Excel magic. We want to select all cells in the table 

(Ctrl+A), select only filtered cells from this selection (Alt+;), copy (Ctrl+C) 
and then Paste ‘As Values’ (Ctrl+Alt+V) in a new tab. 

22. Search (Ctrl+F) for “#VALUE!” and ‘Replace All’ instances with zero (“0”)
23. Select all (Ctrl+A) and ‘Format as Table’. 
24. Let’s fill in ‘Ottawa’ for Geography and rename the field to City. 38



Creating Our 
CANRISK Map 
with Custom 
Regions
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What’s Different About Using Custom Regions?
• With our simple map, Excel used Microsoft’s Bing search 

engine to find the GIS coordinates and boundaries of our 
Provinces (‘standard geography’)

• When using Custom Regions (DA unique identifier) 
however, simply feeding it a Dissemination Area’s unique 
ID won’t be enough to tell the Bing search engine where 
the dissemination area is located and what it looks like.

• Fortunately, Excel allows us to upload shapefiles.

A shapefile is a file format for storing the geometric location 
(i.e. latitude, longitude) and attribute information (e.g. 
Unique ID, English description, population) of a collection of 
geographic features. 
• Geographic features in a shapefile can be represented by 

points, lines, or polygons (areas). 
• A shapefile is actually a small collection of files (3-7) that 

need to be saved together (.shp, .shx, .dbf, etc.).



Creating Our 
CANRISK Map 
with Custom 
Regions

40

IMPORTANT NOTE
Excel 2016 only accepts shapefiles projected formatted as a WGS 1984 Web Mercator 
projection, whereas StatsCan makes its Census Boundary Shapefiles available in NAD 1983
using a PCS Lambert Conformal Conic projection. We have reformatted the Statistics 
Canada shapefiles for CTs, DAs, etc., as WGS1984 and are making them available to you 
today via Dropbox as part of this tutorial.

PCS Lambert Conformal Conic projection

Mercator projectionSee http://www12.statcan.gc.ca/census-recensement/2011/geo/bound-
limit/bound-limit-2016-eng.cfm



Creating Our 
CANRISK Map 
with Custom 
Regions
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Back to Shapefiles…
• We now want to link our data 

(CANRISK Scores) to its respective 
geographic features (Dissemination 
Areas) using each DA’s Unique 
Identifier (UID) as the common thread.

• We call this “joining the data” based on 
the DAUID field. Fields must be an 
exact match for the join to succeed.

• This will give Excel everything it needs 
to map the data:
• Shapefile gives GEOLOCATION
• Data gives VALUES

Excel Data (.xls) Shapefile Data (.shp)



Creating Our 
CANRISK Map 
with Custom 
Regions

Steps
25. Select all (Ctrl+A) and on the Insert Tab, click on the ‘3D Map’ button
26. Click on the ‘Custom Regions’ icon on the Map section of the Ribbon
27. Click ‘Import New Set’ and find your Dissemination Area shapefile (.shp)
28. Select ‘DAUID’ as the join field
29. Set your Location identifier to ‘DAUID’ and choose ‘Custom Region 

(.kml, .shp)’ as the location type. Choose to visualize as Regions 42



Creating Our 
CANRISK Map 
with Custom 
Regions
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Final Exercise

In pairs, create the most insightful and elegant CANRISK map you can come up 

with in 10 minutes, based on the steps covered in Part 1 (see Steps 11-18).

• If the threshold for ‘High Risk’ is a score of ≥ 33 out of 93 points for the full CANRISK 

Assessment Tool, what would a reasonable threshold for ‘High Risk Areas’ be, based 

on the 4 variables (representing a maximum total of 37 points)? 

• Once you have a High Risk Area definition, try to use symbology and other means 

(e.g. filters) to display Dissemination Areas qualifying as High Risk Areas 

prominently on your map.



Creating Our 
CANRISK Map 
with Custom 
Regions

Steps
30. A proportionate High Risk threshold for the 4 fields would be 33/97 *37 = 

13.1  We can use 13.0 to allow for a small margin of error
31. Under Value, add ‘CANRISK’. Display either the ‘Sum’ or ‘Average’
32. Add Filter -> CANRISK scores between 13.00 and 17.69
33. Rename Layer Name to ‘High Risk Areas for Diabetes’ 44

Solution Sheet



Creating Our 
CANRISK Map 
with Custom 
Regions

Final Thoughts:  Creating a Polished Data Product

Other things we might want to do to improve this map:

• Display the Population for each Dissemination Area (2016 Census)

• Add in the name of the Municipality or Neighbourhood corresponding to 
each Dissemination Area (available from Statistics Canada’s DA Boundary 
File reference document)

• Add in the demographic information (Age, Sex, Ethnicity, Education) 

• Add Annotation next to the highest risk areas

• Create a new layer that shows the locations of high-rise buildings and 
seniors residences as points or bubbles on the map; these might be ideal 
targets for screening events

• Would require a new Excel worksheet tab with at least 2 fields: 
‘Location Name’ and ‘Location’ (e.g. Full Address, Lat/Lon coordinates)
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Community 
Data Program 
Resources
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DropBox Files Available

Ottawa Community Data Program’s resource folder for Excel Mapping

• Excel maps for Ottawa with commonly used Custom Geographies:

• CHC/CRC boundaries

• Ottawa Neighbourhoods

• Census geographies (CSD, CT, DA)

Link: 
https://www.dropbox.com/sh/k1qax16qmis77lm/AADELdqxw5a9oiCRMpa8AGK7a?dl=0

Postal Code Conversion File

• Available to Community Data Program members

• Convert your client postal code data to Census boundaries!

Questions About Shapefiles for Ottawa Region?
Contact Stefka at stefkap@spcottawa.on.ca

https://www.dropbox.com/sh/k1qax16qmis77lm/AADELdqxw5a9oiCRMpa8AGK7a?dl=0
mailto:stefkap@spcottawa.on.ca


Thank You
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Let’s Connect!

Questions or Feedback about today’s presentation? 
Contact me at amayer@centretownchc.org


